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Session Information

¢
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This session will be recorded.

This session is scheduled to last 1 houir.

Presentation PowerPoint and recording will be published on ICANNG7
website.

Q&As will be after the presentation.

Please be advised that translation is not supported for this session.
Please submit and ask questions / comments in English.

If you need to post questions / comments in Spanish and French, we
will include our response in the Q&A document that will be published on
the ICANNG7 session page after this session, along with other
questions / comments we could not respond to during the session.
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ICANN Open Data Program

Aims to:

* Increase transparency and e N
improve accessibility & o
availability of data.

e Strengthen ICANN org’s 1
procedures, processes, and '
standards for higher data
usability.




Open Data Platform Launch V1

Session Objective
® Introduce the platform and its functionality.
® Introduce the published datasets.

® Engage and encourage community to access the platform and
available data. Provide feedback to ICANN org to continually
improve this platform and the datasets.

& Register Your Account

Platform will be opendata.icann.org
open to public

later today.
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Agenda

«” ICANN’s Open Data Milestones

Demonstrate ICANN Open Data Platform

“ Demonstrate Published Data
» What's Next

Q Questions and Answers
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Victoria Yang
Operations Senior Program Manager
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ICANN’s Open Data Milestones

LA AA AL

Request For Open Data Purchased the Discussed Implemented Preparation

Proposal data asset Open Data data Open Data for Launch
(RFP) to Inventory Platform & publication Platform V1
acquire a and metadata demonstrated process with design &
SaaS Open public Platform community started
Data Platform comment features dataset
assessment
for
Launch V1




ICANN Open Data Platform

opendata.icann.org
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ICANN Open Data Platform — Home Page

@ One World, One Internet

TCANN

HOME DATA

Back to ICANN Account  SEARCH Q

CHARTS API

Welcome to ICANN Open Data
Platform!

The goal of ICANN's Open Data Program is to provide the ICANN

community with access to publicly available data. You can search,
browse, view, download, and analyze the available data. Please

visit the About page to learn more.

Register to access available data and site features

¢ Browse ICANN Datasets

B Domain Name
(] f\“ Marketplace
Indicators

“\In/i“ 19 dataset(s)

Latest Updates

Number of involuntary gTLD
registrar terminations
Modified a day ago

Number of involuntary gTLD
registry terminations

Modified 4 days ago

Total number of gTLD registry
operator and gTLD registrar
related complaints

Modified 8 days ago

Number of domains by ICANN
region in gTLDs and ccTLDs
Modified 9 days ago

Number of distinct gTLD
registrar entities (Total and
New)

Modified 9 days ago

OTHER ICANN SITES

ICANN.org
|Address Supporting Organization (ASO)
At-Large

ICANN Community Wiki

Country Code Names Supporting Organization (ccNSO)

© 2020 Internet Corporation for Assigned Names and Numbers

Identifier Registry Functions
Activity Reports

Technology Health
Indicators (ITHI)

1 data set(s) 1 dataset(s)

Most Downloaded

ITHI: DNS Root Traffic Analysis
8 downloads

Per-Registrar Transactions
Report 2009

3 downloads

Number of gTLD registrars
accredited and terminated
(Total and New)

2 downloads

Number of domains by ICANN
region in gTLDs and ccTLDs

2 downloads

Total number of gTLD registry
operator and gTLD registrar
related complaints

2 downloads

Generic Names Supporting Organization (GNSO)
Governmental Advisory Committee (GAC)
Root Server System Advisory Committee (RSSAC)

Security and Stability Advisory Committee (SSAC)

Victoria Yang @ Logout v fin

ABOUT HELP

Per-Registrar
Transactions
Reports

11 dataset(s)

Most API Calls

ITHI: DNS Root Traffic Analysis
1225 API calls

Per-Registrar Transactions
Report 2009
724 API calls

Number of domains by ICANN
region in gTLDs and ccTLDs
548 API calls

Number of domains (by TLD
category)

467 API calls

Total number of gTLD registry
operator and gTLD registrar
related complaints

368 API calls

CONNECT WITH US
¥ in f @ o

CONTACT US

CAREERS AT ICANN

Privacy Policy Cookies Policy Terms of Service

 Slides12-13

Slides 14

- Slides 15

Slides 16

Note: Metrics shown on this screen shot is for demonstration purpose only.
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Home Page

Browse all Analyze and Go back to Search Access
available visualize your ICANN datasets by ICANN'’s Social
datasets your data Account keywords Media Platform

@ One WoNd, One Internet Back to ICANN Account SEARCH Q VictoriaYang @ Logout

CHARTS

Welcome to ICANN Open Data :

Platform! W

The goal of ICANN's Open Data Program is to provide the IC*.NN o P EN DATA
community with access to publicly available data. You ca. search,

browse, view, download, and analyze the available d-.a. Please

visit the About page to learn more.

‘ Register to access available data and ~ice features

Learn more about Check out the Help
Open Data Program page for more
and this Platform resources

Search and download
dataset using the API




Home Page

@ One World, One Internet Back to ICANN Account SEARCH Q VictoriaYang @ Logout v fin
ICANN

HOME DATA CHARTS API ABOUT HELP

Welcome to ICANN Open Data :
Platform! WP

The goal of ICANN's Open Data Program is to provide the ICANN O P EN DATA
community with access to publicly available data. You can search,

browse, view, download, and analyze the available data. Please
visit the About page to learn more.

[ BEE— _—=
Register to access available data and site features |
p— |

By registering, your account will allow you to:

% Access and use all data available on this platform for free

% Search, browse, view, download, and analyze the data, according to the
platform’s terms and conditions and the license(s) applied to each datasets

% Save customized analyses

* Choose to receive notifications when selected datasets are updated

% Generate API keys and view API quota usage
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Home Page

Share

Indicators

Browse ICANN Datasets

Domain Name Identifier Registry Functions Per-Registrar
Marketplace Technology Health Activity Reports Transactions

Indicators (ITHI) Reports

1 9 dataset(s) | dataset(s) 1 dataset(s) 11 dataset(s)

Share the ICANN Open Data Platform
home page

«* There are 32 datasets in Launch V1.
+» Users can browse related datasets via these 4
tiles
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Home Page

List of latest 5 datasets
with either the data or

metadata updated

List of top 5 datasets

with the most
downloads

List of top 5 datasets

with the most API calls

Latest Updates

Number of involuntary gTLD
registrar terminations
Modified a day ago

Number of involuntary gTLD
registry terminations
Modified 4 days ago

Total number of gTLD registry
operator and gTLD registrar
related complaints

Modified 8 days ago

Number of domains by ICANN
region in gTLDs and ccTLDs
Modified 9 days ago

Number of distinct gTLD
registrar entities (Total and
New)

Modified 9 days ago

i
Most Downloaded

ITHI: DNS Root Traffic Analysis

8 downloads

Per-Registrar Transactions
Report 2009

3 downloads

Number of gTLD registrars
accredited and terminated
(Total and New)

2 downloads

Number of domains by ICANN
region in gTLDs and ccTLDs
2 downloads

Total number of gTLD registry
operator and gTLD registrar
related complaints

2 downloads

Most API Calls

ITHI: DNS Root Traffic Analysis
1225 API calls

Per-Registrar Transactions
Report 2009
724 API calls

Number of domains by ICANN
region in gTLDs and ccTLDs
548 API calls

Number of domains (by TLD

category)
467 API calls

Total number of gTLD registry
operator and gTLD registrar
related complaints

368 API calls

@

TCANN Note: Metrics shown on this screen shot is for demonstration purpose only.
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Home Page

+* Check out other ICANN sites
+» Connect with us via ICANN Social Media Platforms

s Check out Career Opportunities at ICANN

OTHER ICANN SITES CONNECT 'NVITH US
. You
il
ICANN.org Generic Names Supporting Organization (GNSO) , n F D m
Address Supporting Organization (ASO) Governmental Advisory Committee (GAC)

CONTACT US
At-Large Root Server System Advisory Committee (RSSAC)

CAREEF 5 AT ICANN
ICANN Community Wiki Security and Stability Advisory Committee (SSAC)

Country Code Names Supporting Organization (ccNSO)

© 2020 Internet Corporation for Assigned Names and Numbers Privacy Policy Cookies Policy Terms of Service

Review our Privacy Policy, We are committed to continually
Cookies Policy and Terms of improving this platform. We
Service before using the Open welcome your feedback, please
Data Platform. contact us.




Edman Perez
IT Business Analytics & Intranet Manager
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Data Page

Number of

datasets available |

Sort the datasets
with multiple

options here

Use filters to help
find the datasets

Click on the

dataset to explore
more

Download catalog
allows users to

download the
entire data page
along with the
datasets metadata
12

ICANN

Marketplace Stability

I HOME DATA CHARTS API
32 datasets Compound annual E8 Table
growth rate (CAGR) of
Sort datasets Alphabeticall . Il Analyze
’ 4 number of domains (by M
Modified  Popular =~ AZ i
TLD category) O B
Publisher ICANN Org API
Fllters License Open Database License bg
- (0DbL)
Find a dataset... Q
Domain Name Marketplace
Modified Indicators
2020 32
Mean number of gTLD B Table
registrars per distinct
N " Anal
L LR gTLD registrar entity Ll Analyze
Domain Name Marketplace 19 ) & Export
Indicators Publisher ICANN Org
License Open Database License
BanintamihantlRana P (0DbL) L} API
Robust Competition 12
Registrar 1 .
Domain Name Marketplace
Transacions " Indicators
Marketplace Stability 4
> More
Mean registration period g5 Table
for domains (by gTLD
Download catalog P
il Analy.
category)
. . . i 3. Export
This catalog is available as: publisher  ICANN Org % Expol
ECsv & License Open Database License
(ODbL) L5 APIL
I RDF (Turtle) &
Domain Name Marketplace
& RDF (XML) & Indicators
I RSS feed &

ABOUT

ITHI: DNS Root Traffic
Analysis

Publisher ICANN Org

License Open Database License
(ODbL)

‘ ITHI DNS Root Traffic

Mean number of gTLD
registries per distinct

gTLD registry operator

entity

Publisher ICANN Org

License Open Database License
(ODbL)

Robust Competition

Domain Name Marketplace

Indicators

Net change in number of
domains (by TLD
category)

Publisher
License

ICANN Org
Open Database License
(ODbL)

Robust Competition

Domain Name Marketplace

Indicators

HELP

BB Table
|shl Analyze

& Export

L AP

B Table

|shl Analyze
& Export

L AP

BB Table

[shil Analyze
& Export

4 APIL




Dataset Page

Select the Information tab to find basic
iInformation about the selected dataset

12 records Total number of gTLD registry operator EHEE
and gTLD registrar related complaints

No active filters

O Information &8 Table lul Analyze & Export % API

Filters
The Domain Name Marketplace Indicators present statistics pertaining to the marketplace for generic top-

level domains (gTLDs) and country code top-level domains (ccTLDs).

Search records... Q
ICANN org collaborated with a community Advisory Panel on this effort. The version 1.0 indicator

schema outlines the indicator categories, dimensions / factors, metrics, and includes a glossary of terminology.
The specific calculations performed to arrive upon the indicator values are available in the version 1.0 indicator
taxonomy document.

gTLDs 12
Total number of gTLD registry operator and gTLD registrar related complaints shows how registrants
view contract fulfillment by registrars and registries. Tied to registrant decisions to file complaints after

Segment registry/registrar interaction. Value varies as registrars and registries deliver on obligations.
Registrar-related Complaints 6 Note:
Received 1. ICANN Contractual Compliance Quarterly Reports, Compliance Approach & Process, Available at
) ) https://features.icann.org/compliance/dashboard/report-list
Registry-related Complaints 6
Received 2. The values reported here are as of 30th June (H1) and 31st December (H2) for each calendar year.

@
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Dataset Page

Select the Table tab to view the data

as table

12 records

No active filters

Filters

Search records...

Dimension

gTLDs

Segment

Registrar-related Complaints

Received

Registry-related Complaints
Received

(o)

o

Total number of gTLD registry operator
and gTLD registrar related complaints

O Information

gory

<etplace Stability
<etplace Stability
<etplace Stability
<etplace Stability
<etplace Stability
<etplace Stability
<etplace Stability
<etplace Stability
<etplace Stability
<etplace Stability
<etplace Stability
<etplace Stability

&8 Table

Indicator

MS_1.
MS_1.
MS_1.
MS_1.
MS_1.
MS_1.
MS_1.
MS_1.
MS_1.
MS_1.
MS_1.
MS_1.

1
1
1
1
1
1
1
1
1
1
1
1

lul Analyze & Export 5 API

Dimension Segment Period
gTLDs Registrar-related Complaints Rec 2018 H1
gTLDs Registry-related Complaints Rece 2017 H2
gTLDs Registry-related Complaints Rece 2018 H2
gTLDs Registrar-related Complaints Rec 2017 H2
gTLDs Registrar-related Complaints Rec 2018 H2
gTLDs Registrar-related Complaints Rec 2019 H1
gTLDs Registry-related Complaints Rece 2017 H1
gTLDs Registry-related Complaints Rece 2018 H1
gTLDs Registry-related Complaints Rece 2019 H1
gTLDs Registrar-related Complaints Rec 2016 Total
gTLDs Registrar-related Complaints Rec 2017 H1
gTLDs Registry-related Complaints Rece 2016 Total

v flin}s|

Value &
17,015
597
443
24,360
17,957
11,845
882
543
1,390
43,156
24,650
2,230

Notes

@

ICANN
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Dataset Page

@

ICANN

Select the Analyze tab to view the data as chart

12 records

No active filters

Filters

Search records... Q

gTLDs 12

Registrar-related Complaints 6
Received
Registry-related Complaints 6
Received

2016 Total 2
2017 H1 2
2017 H2 2
2018 H1 2

Total number of gTLD registry operator EHEEE]
and gTLD registrar related complaints

O Information &8 Table & Export of API

X axis Period : Max. number of points  Show all
Break down series Segment : Stack No stack % + Add a series
| Columnchart % ”I" Yaxis Sum + Value §
50k
40k
Y 30k
=
>
E
A 20k
10k
0 | — —_— —_— - —
g 3\ R \x\ 3\ N
o ~ -~ NG N ~
> v v v Vv Vv
Period

Registrar-related Complaints Received @ Registry-related Complaints Received

Edit in advanced mode

Please visit the Help page for more information and other available

resources.
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Dataset Page

Select the Export tab to export the dataset in
your preferred format

© Information &8 Table Ll Analyze

Total number of gTLD registry operator EEEE
and gTLD registrar related complaints

& Export

5 API

dataset's license (Open Database License (ODbL)).

In order to download this dataset, you need to accept the portal's terms and conditions and the

v I accept the portal's terms and conditions and the license applicable to the dataset.

HOME

12 records

No active filters

Filters

Search records...

gTLDs

@

ICANN

DATA

CHARTS API ABOUT

Total number of gTLD registry operator
and gTLD registrar related complaints

© Information &8 Table [l Analyze 5 API

This dataset is licensed under : Open Database License (ODbL)

Flat file formats

csv & Whole dataset

CSV uses semicolon (;) as a separator.

JSON & Whole dataset

HELP

v fin]s]
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Dataset Page From any tab, you can share a link to a
dataset on social media or by email

. Total number of gTLD registry operator C 1K E =D
and gTLD registrar related complaints

Active ﬁlters @ Clear all O Information BB Table Ll Analyze & Export «f API

Registry-related

Complaints Received

Filters | Column chart % Il vaxis sum
Search records... Q

Dimension

)

1500

gTLDs

Segment

St

)

Registry-related Complaints
Received

o
& & &
< Q Q RS
&2 " o W
Period |
Registry-related Complaints Received

2016 Total
2017 H1
2017 H2 Share A Embed Widget

2018 H1

ttps://opendata.icann.org/explore/embed/dataset/total-number-of-gtld-registry-operator-an. =~ Iy
2018 H2

You also can share the dataset via embed or widget features,
where applicable:

s Share: Selection will allow you to copy and paste a shareable URL
% Embed: Selection will generate the iframe code of the visualization.
% Widget: Selection will generate the widget code of the visualization.

@
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Other Pages:

® Charts page

o With the Chart builder tool, you can visualize
multiple datasets on a single customized chart.

o Compare to the Analyze tab on a dataset page, this

page will give your more options, such as combining
different datasets.

® API page
o The API (Application Programming Interface) is an
interface for programs to communicate and
exchange data.

® Please visit the About page and Help page for more
information and available resources.

Q | 24
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Mukesh Chulani
gTLD Accounts Senior Manager

e | 25

NNNNN



Domain Name Marketplace Indicators

® The Domain Name Marketplace Indicators presents statistics
pertaining to the marketplace for generic top-level domains
(gTLDs) and country code top-level domains (ccTLDs).

® ICANN org collaborated with a community Advisory Panel to
develop relevant indicator schema and taxonomy.

® ICANN org has released 2 refreshes so far, which are available on
icann.org in Excel sheet format. These indicators are updated twice
a year.

® Transitioning from Excel sheet on icann.org to Open Data Platform
not only provides users ability to refine the data with search and
filter functionality, but also the opportunity to visualize data and tell
their stories.

5% | 26
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https://www.icann.org/resources/pages/metrics-gdd-2015-01-30-en

Example

Number of domains (by TLD category)

© Information &8 Table Ll Analyze & Export of API
X axis Period v Max. number of points  Show all $
Break down series Segment + Stack Normal #%
Areaspline § . Yaxis Sum + Value §
6M
am
@
]
K}
>
13
E
A
M

+ Add a series

Number of domains (by TLD category)

@ Information &8 Table [l Analyze & Export of API
Xaxis  Period + Max. number of points Showall §
Break down series Segment v Stack Normal %
Areaspline % . Yaxis Sum 4 Value

250M

200M

—
“u
1=}
=

Sum Value

100M

50M

+ Add a series

Period

IDN ccTLDs
@ IDN gTLDs

Legacy gTLDs
@ New gTLDs

@

ICANN
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| Alain Durand
Y/ Principal Technologist
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Identifier Technology Health Indicator (ITHI)

® In 2017, ICANN started the project to monitor the health of the
registered identifiers ecosystem through a set of Identifier Technology
Health Indicators (ITHI) or ITHI Metrics. The eight metrics (indicators)
along with its detailed data can be seen on the site
https.://ithi.research.icann.org.

® Metrics 3 (M3) — DNS Root Traffic Analysis is published via Launch
V1.

® The move of this metric (ITHI M3) to the Open Data Platform will
enable users to access all historical data and timely update with new
data. Today, data published on ITHI site is a snapshot of past 3
months; however, in Open Data Platform, it includes monthly data
beginning of Jan 2018, and data will be modified every month with
additional monthly data.

® ICANN org will continue maintaining the ITHI site in parallel with
publishing data on Open Data Platform.

% |29
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https://ithi.research.icann.org/

Russ Weinstein
Sr. Director, gTLD Accounts & Services
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Monthly Registry Reporting

® Registry Functions Activity Reports and Per-Registrar Transaction
Reports are submitted to ICANN as part of contractual obligations.

® Both reports are currently published on icann.org.

® Both reports are not published until three months after the end of
the month to which the report relates.

® Moving both reports from icann.org to Open Data Platform made
the data easier to consume. E.g. the Per-Registrar Transaction
Report structured by year contains approximately 1 million records
(# of rows), users can consume all TLD transactions data of 12
months by accessing 1 dataset.

® The data will continue to be available in its current format on
icann.org until FY21 Q2, after which, the data will be discontinued
on icann.org and only be available via the Open Data Platform.

QL | 31
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https://www.icann.org/resources/pages/registry-reports

Example

@

ICANN

985,358 records

No active filters

Filters
Search records... Q
TLD
com 28,538
net 28,258
org 20,269
info 4,744
biz 3,832
Xyz 3,377
> More

12 85,310
" 85,129
10 84,531
09 83,936
08 83,500
07 83,056

Per-Registrar Transactions Report 2018 EHEEE

O Information

TLD
1 miami
2 miami
miami
miami
miami
miami
miami
miami
miami
10 miami
11 miami
12 miami
1 miami
14 miami
1t miami
16 miami
17 miami
18 miami
19 miami
miami
miami

22 miami

Share

&8 Table
¢ VYear Month
2018 02
2018 02
2018 02
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10

A Embed

Widget

lal Analyze

registrar-name
porkbun_mm

Hosting Ukraine LLC

Domain Research, LLC

Register.com, Inc.
COREhub, S.R.L.
Tucows Domains Inc.
1&1 Internet SE

Whois Networks Co., Ltd.

Ascio Technologies, Inc. Danmar}

Secura GmbH
GoDaddy.com, LLC

PSI-USA, Inc. dba Domain Robot

CSC Corporate Domains, Inc.

Sea Wasp, LLC
DomainName, Inc.
EnCirca, Inc.

DomainSite, Inc.

Nom-iq Ltd. dba COM LAUDE

Epik, Inc.

Name.com, Inc.

IP Mirror Pte Ltd dba IP MIRROR

Net 4 India Limited

& Export

% API

iana-id ©
1,861
2,374
2,484
9

15
69

83
100
106
11
146
151
299
411
450
455
466
470
617
625
890
1,007

total-domains ©
44

0

0

14

0

147

215

24

6,174

31
193

28
5,520
112

0

https://opendata.icann.org/explore/embed/dataset/per-registrar-transactions-report-2018/takt

total-r
23
0

0
28
0
97
284
4
35
0
533
20
49
0

0

0

0
1

89
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Example

@

ICANN

4,744 records

@ Clear all

Active filters

info

Filters
Search records... Q
TLD
com 28,538
net 28,258
org 20,269
info 4,744
biz 3,832
Xyz 3,377

01 409
02 409
03 409

Per-Registrar Transactions Report 2018 EHEE

© Information

D ©
1050 info
1051 info
1052 info
info
1054 info
info
1056 info
info
1058 info
info
1060 info
1 info
1062 info
info
1064 info
info
1066 info
info
1068 info
info
1070 info

1071 info

Share

&8 Table

Year Month

2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
2018 01
A Embed

Ll Analyze

registrar-name

101domain GRS Ltd
10Dencehispahard SL

AB Name ISP

Abraham Lincoln, LLC
Achilles 888, LLC

Address Creation, LLC
Adomainofyourown.com LLC
Alantron Bilisim Ltd Sti.
Alexander the Great, LLC
Alice's Registry, Inc.
Allearthdomains.com LLC
Alpnames Limited

Arcanes Technologies

Arctic Names, Inc.

Ares 888, LLC

Ascio Technologies, Inc. Danmar}
Astutium Limited

Atak Domain Hosting Internet ve
AtlanticFriendNames.com LLC
Azdomainz LLC

BB Online UK Limited

Belmontdomains.com LLC

Widget

& Export

£ API

iana-id ©
1,011
1,403
1,371
2,289
2,290
270
1,158
898
1,702
275
1,159
1,857
3,245
1,340
2,293
106
1,471
1,601
1,157
1,391
134
1.163

total-domains ©
2,874
1,880
1,451
1

1

20

323

70

10
197
309
489

43

154

6
55,110
126
92

325

257
303

total-name

70

-
O o

N N O N A O O O

N W
wv

277

12

o O O N

https://opendata.icann.org/explore/embed/dataset/per-registrar-transactions-report-2018/tat =~ Iy
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Victoria Yang
Operations Senior Program Manager
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What’s Next

The Platform URL is
opendata.icann.org

Register your account to
access the available
datasets

The Platform will be
open to public later
today

Let us know your
feedback via
“Contact Us” on the
Platform

ICANN org will continue
improving the Platform
and datasets based on
your feedback and
assessing new datasets
for publication.
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Questions and Answers

%+ Please raise your hand in zoom if you want to ask a question
% The Remote Participants Manager will manage the queue.

s Unmute your microphone to ask questions when is your turn
* Mute your microphone when not speaking

s Type your questions in the chat
+ The Remote Participants Manager will read out your
question(s).

O

Questions / comments in Spanish and French, along with other
questions / comments we could not respond to during the session,
will be published on the ICANNG7 session page after this session

We are committed to continually improving this Platform.
We welcome your feedback, please contact us via the
“Contact us” on the Home Page footer.
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Thank You Very Much

3’@ One World, One Internet

ICANN

Visit us at icann.org

@icann
facebook.com/icannorg
youtube.com/icannnews
flickr.com/icann
linkedin/company/icann
slideshare/icannpresentations

soundcloud/icann

0660000




